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1. CREATING JMETER TEST PLAN
v' C1-Thread Group
v' C2 - Config Element
v. C3 - Controller
v' C4 - Listener

Ol




CREATING TEST PLAN
1. Add Thread Group

Thread group element controls the number of threads JMeter will use to execute your test.

The controls for a thread group allow you to:
v' Set the number of threads
v Set the ramp-up period
v' Set the number of times to execute the test
v' Scheduler

I I
.
Add > Threads (Users) Thread Group
bzm - Arrivals Thread G
Paste Ctrl+V Config Element i - A Tread botp
List bzm - Concurrency Thread Group
istener
Open... bzm - Free-Form Arrivals Thread Group
Merge Timer Jp@gc - Stepping Thread Group (deprecated)
Save Selection As... Pre Processors jp@gc - Ultimate Thread Group L
Save Node As Image  Ctrl+G Post Processors setUp Thread Group
Save Screen As Image Ctrl+Shift+G Assertions tearDown Thread Group
Enable Test Fragment Add Add from Clipboard Delete
Disable Non-Test Elements
Toggle Ctrl+T Run Thread Groups consecutively (i.e. one at a time)

Help

Run tearDown Thread Groups after shutdown of main threads



CREATING TEST PLAN
1. Add Thread Group Untuk Recording

Thread Group

Name: Thread Group

Comments:

Action to be taken after a Sampler error

(®) Continue (") Start Next Thread Loop (O) Stop Thread (O) Stop Test  (_) Stop Test Now

- Thread Properties

Number of Threads (users): 1 -

Ramp-Up Period (in seconds): F

Loop Count: [_] Forever ‘1

[] Delay Thread creation until needed

[[] scheduler

- Scheduler Configuration
/1 If Loop Count is not -1 or Forever, duration will be min(Duration, Loop Count * iteration duration)

Duration (seconds)

Startup delay (seconds)




CREATING TEST PLAN
1. Add Thread Group e

Thread Group

Name: Thread Group

Comments:

Action to be taken after a Sampler error

(@ Continue () Start Next Thread Loop () Stop Thread () Stop Test (7)) Stop Test Now

~Thread Properties |
Number of Threads (users): 10

Ramp-Up Period (in seconds): 100
Loop Count: [ ] Forever 1

[] Delay Thread creation until needed

[v] Scheduler

~Scheduler Configuration
/1 If Loop Count is not -1 or Forever, duration will be min{Duration, Loop Count * iteration duration)

Duration (seconds) _2DD|

Startup delay (seconds)




CREATING TEST PLAN

01:48:02 01:48:12 01:48:22 == o= 01:49:22 01:49:32

10s 108 108

Thread 1 ————. :

Thre,ad 2 "———ﬁ. _—
Thread 2|start 10s

after Thread 1

Thread 3 M "=
Thread 3 start 10s
after Thread 2
Thread 9 —4—. =
Thread 10

Thread |0 start
10s after Thread 9
_

Total: 100s = Ramp-up. After 100s, all 10 threads are up and running




CREATING TEST PLAN
2. Add Config Element

Config Element:

v User Defined Variables
v HTTP Request Defaults
v HTTP Cookie Manager
v HTTP Cache Manager




CREATING TEST PLAN

2. Add Config Element > User Defined Variables

Paste

Open...
Merge
Save Selection As...

Ctrl+V

Save Node As Image Ctrl+G

Save Screen As Image Ctrl+Shift+G

Enable
Disable
Toggle

Help

Ctrl+T

> Threads (Users) ’

Config Element :

Listener
Timer

Pre Processors
Post Processors

Assertions

Test Fragment

MNon-Test Elements >
un Thread Groups consecuti

un tearDown Thread Groups
[ ] Functional Test Mode (i.e. say

Selecting Functional

Add directory or jar to classpath

Library

CSV Data Set Config
HTTP Header Manager
HTTP Cookie Manager
HTTP Cache Manager
HTTP Request Defaults

Counter

DNS Cache Manager

FTP Request Defaults

HTTP Authorization Manager
JDBC Connection Configuration
Java Request Defaults

Keystore Configuration

LDAP Extended Request Defaults
LDAP Request Defaults

Login Config Element

Random Variable

Simple Config Element

TCP Sampler Config

User Defined Variables




CREATING TEST PLAN
2. Add Config Element> User Defined Variables

User Defined Variables

Name: ‘User Defined Variables
Comments: ‘
User Defined Variables
Mame: Value Description
host 10.85.226.243
scheme hitp
path /heskiadmin




CREATING TEST PLAN
2. Add Config Element > Http Request Default

11
Add

Paste Ctrl+V

Open...
Merge
Save Selection As...

Save Node As Image Ctrl+G
Save Screen As Image Ctrl+Shift+G

Enable
Disable

Toggle Ctrl+T

Help

Threads (Users) ? ‘

e

Config Element

Listener
Timer

Pre Processors
Post Processors

Assertions

b
L

Test Fragment

Non-Test Elements

Run Thread Groups consecuti

Run tearDown Thread Groups

[] Functional Test Mode (i.e. sa

Selecting Functional

Add directory or jar to classpath

Library

CSV Data Set Config
HTTP Header Manager
HTIP Cookie Manager
HTIP Cache Manager
HTTP Request Defaults

Counter

DNS Cache Manager

FTP Request Defaults

HTTP Authorization Manager
JDBC Connection Configuration
Java Request Defaults

Keystore Configuration

LDAP Extended Request Defaults
LDAP Request Defaults

Login Config Element

Random Variable

Simple Config Element

TCP Sampler Config




CREATING TEST PLAN
2. Add Config Element > Http Request Default

HTTP Request Defaults

Name: HTTP Request Defaults

Comments:

Input protocol , server name, path
Basic Advanced

Web Server

Protocol [http]: ${scheme} ' Server Name or IP: ${host} Port Number:
HTTP Request

Path: ${path} Content encoding:

Parameters Body Data

The main goals of using the HTTP Default Request is to:
v" Avoid data duplication in tests. VARIABLE IN JMETER

v" Make test scripts more (easily) maintainable. ${variable}




CREATING TEST PLAN
2. Adding Config Element> Http Cookie Manager

Ll

Add > Threads (Users) > ‘
Paste Ctrl+V Config Element : CSV Data Set Config
Listener ; HTTP Header Manager
Open... _
HTTP Cookie Manager
Merge Timer
) HTTP Cache Manager
Save Selection As... ]
Pre Processors 1 HTTP Request Defaults
Save Node As Image Ctrl+G Post Processors
) . Counter
Save Screen As Image Ctrl+Shift+G Assertions
DNS Cache Manager
Enable Test Fragment ; FTP Request Defaults
Disable Non-Test Elements HTTP Authorization Manager
Toggle Ctrl+T roups conseculively (i.e. o JDBC Connection Configuration
Help n Thread Groups after shutd Java Request Defaults
[ ] Functional Test Mode (i.e. save Response Keystore Configuration
LDAP Extended Request Defaults
Selecti F ti 1l Test M
shEching bunetiona == ) LDAP Request Defaults
Add directory or jar to classpath = Browse... Login Config Element
} Random Variable
Library
Simple Config Element
TCP Sampler Config




CREATING TEST PLAN

2. Add Config Element> Http Cache Manager

Add

Paste Ctrl+V

Open...
Merge
Save Selection As...

Save Node As Image Ctrl+G
Save Screen As Image Ctrl+Shift+G

Enable
Disable

Toggle Ctrl+T

Help

>

[ ] Functional Test Mode (i.e. save Response

Selecting Functional Test Mc

Add directory or jar to classpath

n Thread Groups after shutdc

Threads (Users) > ‘

Config Element :

Listener
Timer

Pre Processors
Post Processors

Assertions

Test Fragment

Non-Test Elements
roups consecutively (i.e, one

Browse...

Library

CSV Data Set Config
HTTP Header Manager
HTTP Cookie Manager
HTTP Cache Manager
HTTP Request Defaults

Counter

DNS Cache Manager

FTP Request Defaults

HTTP Authorization Manager
JDBC Connection Configuration
Java Request Defaults

Keystore Configuration

LDAP Extended Request Defaults
LDAP Request Defaults

Login Config Element

Random Vanable

Simple Config Element

TCP Sampler Config




CREATING TEST PLAN

3. Add Controller

 JMeter can record your
testing steps.

 Recording controlleris a
placeholder to store these
recording steps.

=

Test Plan
){' User Defined Variables
)é:' HTTP Request Defaults
% HTTP Cache Manager
% HTTP Cookie Manager
U 1

Thread Group
Name: Thread Group

Comments:

Add

Start
Start no pauses
Validate

Cut
Copy
Paste
Duplicate

Remove

Open...
Merge
Save Selection As...

Save Node As Image
Save Screen As Image

Add Think Times to children

Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+Shift+C
Delete

Ctrl+G
Ctrl+Shift+G

Sampler
Logic Controller

Pre Processors
Post Processors

Assertions
Timer
Test Fragment

Config Element

Listener

rt Next Thread Loop

(") Stop Thre

If Controller
Transaction Controller
Loop Controller
While Controller

Critical Section Controller
ForEach Controller
Include Controller
Interleave Controller
Once Only Controller
Random Controller
Random Order Controller
Recording Controller
Runtime Controller
Simple Controller
Throughput Controller



CREATING TEST PLAN
4. Adding Listener

. Apache JMeter (5.1.1 r1855137)

File Edit Search Run Options Tools Help

* A listener is a component that B Y LT ETEEETNYY YT
shows the results of the samples. = & resten

. . - & User Defined Variables Thread Group
v" View Results Tree - to view the 24 HTTP Request Defauks Neme: [Thread Grou
- J HTTP Cache Manager
contents of a response from any  J+ e coskie Mansger Comments:
N ! U
given sampler T o > sampler =
v Summary Report - shows Add Think Times to children e
St
values about the measurement ;:p Pre Processors
JMeter has done while calling Validate S
the same page in tabular format Cut Ctrl+X .
Imer
Copy Ctrl+C
Paste Ctrl+V Test Fragment
Duplicate Ctrl +Shift+C Confi Element )
Remove Delete Listener 1
Open... 5) 200
Merge conds)
Save Selection As... '

View Results Tree
Summary Report
Aggregate Report
Backend Listener

Aggregate Graph

Assertion Results

Comparison Assertion Visualizer
Generate Summary Results

Graph Results

JSR223 Listener

Mailer Visualizer

Response Time Graph

Save Responses to a file

Simple Data Writer

View Results in Table

jp@gc - Active Threads Over Time
jp@®gc - Flexible File Writer

Jp@gc - PerfMon Metrics Collector
jp@gc - Response Times Over Time
jp@®gc - Transactions per Second
BeanShell Listener




USING TEMPLAT

* Klik File -> Template -> « Tambah dan kemaskini komponen
* Pilih Recording JMeter yang diperlukan.

|£ | Templates

BeanShell Sampler

Functional Testing Test Plan [01]
JDBC Load Test

JSR223 Sampler using Groovy
MongoDB Load Test

Recording

Recording with Think Time
Simple HTTP request

Think Time at a point

* Klik Create, seterusnya Create

? @ TestPlan
#%. User Defined Variables
# HTTP Request Defaults
}q": HTTP Cookie Manager
? &% Thread Group
iz Recording Controller
View Results Tree

A,
B HTTP(S) Test Script Recorder

?
~_ View Results Tree




LET'S DO IT
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2. RECORDING AND SCRIPTING

v R1- Script Recording
v' R2 - JMeter Certificate (https recording)




RECORDING
1. Script Recording

Steps of Script Recording

v" Add Non-Test Element HTTP(s) Test Script Recorder
v’ Certificate Check
v Enter the port number which is not in use. (8888)
v Apply proxy on the browser you want to record and use the same port
humber
v’ Start the JMeter Proxy Server
v' Record the Actions > Transaction Control




RECORDING

1. Add HTTP(S) Test Script Recorder

 Can be used to record all the requests which your web or
mobile application is making to server.
« Capture the HTTP(s) requests.

= s

-){'U:

o Th

Add > Threads (Users)

) .
Paste Ctrl+V Config Element >

Open.. Listener 4

Merge Timer > User Defined Varial
save Selection As... Pre Processors >

Save Node As Image Ctrl+G Post Processors >

Save Screen As Image Ctrl+Shift+G Assertions >

Enable Test Fragment > Add a1 B
Disable Non-Test Elements > HTTP Mirror Server

Toggle Ctrl+T [Groups consecutively (i.e. on HTTP(S) Test Script Recorder

Help vn Thread Groups after shutd

Property Display




RECORDING

2. Add Port Number

a) Port - Ensure the port

number is not being
used and as same as
stated in browser.

b) Test Plan Creation:
 Target Controller
* Grouping
 Transaction name

State

Global Settings
Port: 8888 |

P start

Stop Restart

HTTPS Domains:

| Test Plan Creation i/ Requests Filtering |

Test plan content
Target Controller:
Grouping:

Capture HTTP Headers

HTTP Sampler settings

Transaction name

Naming scheme | Transaction name | V|
Counter start value

Create new transaction after request (ms):

Recording's default encoding

D Retrieve All Embedded Resources
Use KeepAlive

Type:

GraphQL HTTP Sampler settings

Detect GraphQL Request

hesk > createuser > Recording Controller-createuser ‘ v |
Put each group in a new transaction controller ‘ v|
[ | Add Assertions Regex matching
|Landingpage
|UTF-8 |
[ ] Redirect Automatically Follow Redirects
]




RECORDING

3. Proxy Setting in Browser

Connection Settings

* —Firefox Configure Proxy Access to the Internet Port number !*nust
-General -> Network Setting -> o ron 25 BRI U

) HTTP(S) Test Script
sett |.n g -> Ma n Ual. p roxy () Auto-detect proxy settings for this network Recorder
configuration

() Use system proxy settings

O Manual proxy configuration

HTTP Proxy | localhost ‘_Port‘ 8888 ‘

Also use this proxy for HTTPS

HTTPS Proxy | localhost Port 8888

SOCKS Host ‘ Por;‘ 0 ‘

) socksva © SOCKS v5




RECORDING

3. Proxy Setting in Browser

e Chrome .
. i Edit proxy server Port number must
-Setting -> Proxy-> Setting -> e

Use a proxy server
Use a proxy server: ON — HTTP(S) Test Script

‘) On
Proxy IP address: http://localhost Recorder
Port: 8888 Proxy IP address Port
http://localhost 8888

Use the proxy server except for addresses that start with the following entries.
Use semicolons (;) to separate entries.

O Don’t use the proxy server for local (intranet) addresses

Save Cancel



http://localhost/

RECORDING
9. Start JMeter Proxy Server

Click “Start” to initial
the recording

State

Global Settings
Port: 5888

| Test Plan Creation i/ Requests Filtering

Click Here

|4
P start

Stop

Restart

HTTPS Domains:

Test plan content

Target Controller:
Grouping:

Capture HTTP Headers

HTTP Sampler settings

Transaction name

Naming scheme | Transaction name | V|

Counter start value

Create new transaction after request (ms):

Recording's default encoding
D Retrieve All Embedded Resources

Use KeepAlive
Type:

GraphQL HTTP Sampler settings

Detect GraphQL Request

Choose the
right onel

hesk > createuser > Recording Controller-createuser ‘ v |
‘ Put each group in a new transaction controller ‘ v |
[ | Add Assertions Regex matching

|Landingpage

|UTF-8 |

[ ] Redirect Automatically Follow Redirects

| ]




RECORDING

6. Record the Actions

* Transaction Control
v Use to name the transaction

v Input the name before proceeding to next transaction

- Global Settings
Port: |8888 HTTPS Domains:

Test Plan Creation Requests Filtering
~Test plan content

Target Controller: sistemhesk > CreateNewUser > Recording Controller-CreateNewUser v

Grouping: Put each group in a new transaction controller v [v] Capture HTTP Headers | | Add Assertions [»/] Regex matching

HTTP Sampler settings

Transaction name . _
Create new transacl Recorder: Transactions Control

Transaction name

[ Retrieve Al Emt HTTP Sampler settings

[]Redirect Autom: Stop
[] Use KeepAlive

Transaction name: -
Create new transaction after request (ms):

Landingpage

Type:




PERFORMING LOAD TEST
2. JMeter Certificate

Chrome:
C, ~ Setting > Manage Certificate > Trusted Root Certification Authorities >
Import >

certificate masih

Pastikan Jmeter
valid

browse file > .\apache-jmeter-5.1\bin

\
, Firefox:
~ Option > Certificate > View Certificate > Authorities > Import

./bin/ApacheJMeterTemporaryRootCA




LET'S DO IT




Transaction Name/Prefix

Activities Create User

Landingpage

Type url your_ip_address/hesk/admin

Login Fill up login credential
administrator, administrator
Clickusers Click tab users
Fill up user info
* Fill up Profile Information
v" Real name: pengguna0]
v' Email: pengguna0l@gmail.com
v' Username: pengguna01
v' Password: password
v" Confirm password: password
 Permission
v’ Click : Staff
v' Choose : Can run reports (all)
Createuser Click Create User
Logout Click logout




Transaction Name/Prefix

Activities Create Ticket

Landingpage

Type url your_ip_address/hesk/admin

Login Fill up login credential
username01, password
Newticket Click tab +New Ticket

Fill up the form:
Name:

Email:

Priority:
Subject:
Message:
Untick:

Createticket

Click Submit Ticket

Gohome

Click Home

Logout

Click Logout




3. VERIFYING SCRIPT

v V1 - Check Recorded Transaction
v V2 - Run Recorded Transaction
v V3 - View Result Tree

a Regular Expression Extractor
- Response Assertion
v’ V4 - View Summary Report




VERIFYING RESULT

1. Check Recorded Transactions

« All the transactions will be recorded under “Recording Controller”
« Can remove unnecessary component such as *.css, *.png, *.txt and so on.

Tn Recording Controller

P #* FirstPa

g ,-;'r"" Search241 ftemplatesirt_isotopel/customicss/idemo.css

&, . . . -4 | P T i I-hi 2017
P A ClickFirstLink243 ims/arkib-2017/733-notis-tender-sebut-harga-mei-hingga-september-2017
B #" ClickFirstLink2




VERIFYING RESULT

2. Run Recorded Transactions Click Start to run

the script

eptember-2017




VERIFYING RESULT

3. View Result Tree

The View Results Tree shows:
v A tree of all sample responses
v" Response code
v Assertion result
v" Time it took to get this response

No error found!

=
115]
Fal
-
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l:?-.
?.
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I::f.
I::-(:.
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l:?-.
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I::f.
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FirstPage236 /ms/

FirstPage236 /ms/

Search238 ims/fcomponentfinder/
Search239 /msicomponentfinder/
Search240 imsicomponentfinder/search
Search240 Ims/componentfinder/search

=

ClickFirstLink243 /ms/arkib-2017/7 33-notis-tender-sebut-h;
ClickFirstLink243 /ms/arkib-2017/7 33-notis-tender-sebut-h;
FirstPage236 /ms/

FirstPage236 /ms/

Search239 imsfcomponentfinder/

Search238 ims/fcomponentfinder/

Search240 /msicomponentfinder/search

Search240 imsicomponentfinder/search

ClickFirstlink243 /ms/arkib-2017/7 33-notis-tender-s ebut-h;
ClickFirstLink243 /ms/arkib-2017/7 33-notis-tender-sebut-h;
FirstPage236 /ms/

FirstPage236 /ms/

Search239 imsfcomponentfinder/

Search239 imsfcomponentfinder/

Search240 /ms/componentfinder/search

Search240 /msicomponentfinder/search

ClickFirstLink243 ims/arkib-2017/7 33-notis-tender-s ebut-h;
ClickFirstlink243 /ms/arkib-2017/7 33-notis-tender-s ebut-h;
FirstPage236 /ms/

Search238 /ms/componentfinder/

FirstPage236 /ms/

Search239 imsfcomponentfinder/

Search240 imsfcomponentfinder/search

Search240 /ms/componentfinder/search

lickFirstLink243 ims/arkib-2017/7 33-notis-tender-s e but-h;
lickFirstLink243 ims/arkib-

™
b
™
b

Sampler result Request Response data

Thread Mame: Thread Group 1-1
Sample Start: 2018-11-28 00:49:45 3GT
Loadtime: 6356

Connect Time: 18

Latency: G326

Size in bytes: 19465

Sent bytes 329

Headers size in bytes:

Body size in bytes: 18940
Sample Count: 1

Error Count: 0

Data type ("text™|"bin”[™): text
Response code: 200

Response message: O

HTTPSampleResult fields:
ContentType: texthtml; charset=uti-3
DataEncoding: utf-a




VERIFYING RESULT

If error found?

Check error code (401, 404..) in Response Body, Sampler Result
Check if token used (variable need to be declared)
 Authentication issue - user account



VERIFYING RESULT m

 Add Regular Expression Extractor

 Check if there any token used
(variable need to be declared)

 Replace the token value with (_ +?)

 Variable in JMeter

${variable}



VERIFYING RESULT

« Cari ‘token'dalam response data->Response hody
(satu level (up) di mana error token berlaku)

Text M Sampler result r Request i/ Response data |

@ Landingpage-44 (Response Body i/Response headers |

Landi ]

g andingpage token Find DCasesensitive DRegulare:
- Login-45

v g_ <td><a href="reports.php™<img src="../Img/Ico_reports.gif” width="26" helght="26" border="0" alt="Reporis" title="Reports" /><br />Reports</a><br /><In

©@ Login-46 <td>&nbsp;&nbsp;&nbsp;</td>

&7 Login-48 :

& Login <td><a href="banned_emails.php"><img src="../img/ico_tools.png" width="26" height="26" border="0" alt="Tools" title="Tools" /><br />Tools</a><br /><ir

@ Clickusers-52 <td>&nbsp;&nbsp;&nbsp;</td>

@ Clickusers :

<td><a href="admin_settings.php"><img src="../img/ico_settings.gif" width="26" height="26" border="0" alt="Settings" title="Settings" /><br />Settings</a>

o &9 | Createuser-54 <td>&nbsp;&nbsp;&nbsp;</td>

& Createuser-56
17 Createuser
&7 Logout-59
&7 Logout

<td><a href="profile.php"><img src="../img/ico_profile.gif" width="26" height="26" border="0" alt="Profile" title="Profile" /><br />Profile</a><br /><img src=
<td>&nbsp;&nbsp;&nbsp;</td>

<td><a href="mail . php"><img src="../img/ico_mail.gif" width="26" height="26" border="0" alt="Mail" title="Mail" /><br />Mail (0)</a><br /><img src="../img/k
<td>&nbsp;&nbsp;&nbsp;</td>

<td><a href=“index.php?a=|ogout&amp-=09<:bd1le349581da0955f1 bdbde10880bed7163"><img src="../img/ico_logout.gif" width="26" height="26" k
<fr>

</table>

Error : Invalid.. <id>




VERIFYING RESULT

« Salin format token dan gantikan nilai token
dengan (_+?) Gantikan

dengan (.+?)

« token=09chbdl1e9f349581da0955f1bdbde10880bed7163">
« token=(.+7)">



VERIFYING RESULT

?

0=
o=

Tambah Regular Expression Extractor pada

http

request di mana token dijumpai

Boundary Extractor

-iﬁj createuser L) Ay
'i; - Recording Controller-createuser Protocol [http]: |${scheme} | Server Name or IP: |${host}
o . Landingpage : HTTP Request
o = Login ‘GET ‘vl Path: ‘fheskfadmimmanage_users,php
¥k Clickusers 3 [I Redirect Automatically Follow Redirects Use Kee|
¢ " Clickusers-52
;{ HTTP H Add Assertions b hrameters I/ Body Data |/ Files Upload ‘
' Regular Insert Parent Timer 3
¥ Regular| Cut g Pre Processors P Name: | Val
o= |- Createuser Copy SIRE Post Processors f| CSS Selector Extractor
o = Logout Paste e Config Element » JSON Extractor
crealelickel Duplicate ClsShitC | | - tener p JSON JMESPath Extractor
viewreport Remove Delete

-m‘ View Results Tree
',-L Summary Report
o [l HTTP(S) Test Script Rec

Open...
Merge
Save Selection As...

Save as Test Fragment

Save Node As Image Ctrl-G

Save Screen As Image Cirl+Shift-G

Enable
Disable
Toggle

Ctrl-T

Regular Expression Extractor
JSR223 PostProcessor

Debug PostProcessor

JDBC PostProcessor

Result Status Action Handler

XPath Extractor

XPath2 Extractor

jp@gc - Add Dummy Subresult

jp@gc - Inter-Thread Communication PostProcessor

Regular Expression Extractor

Name: |Regular Expression Extractor

Comments: |
Apply to:
(O Main sample and sub-samples ® Main sample only () Sub-sample:

() JMeter Variable Name to use

Field to check

O Body @] Body (unescaped) O Body as a Document esponse Headers (@) Request Headers O URL

Name of created variable: \token
Regular Expression: \token:(_+'?)“>
Template ($i$ where i is capturing group number, starts at 1) ‘$1$

Match No. (0 for Random): ‘1

Default Value: ‘

| |:| Use empty default value




VERIFYING RESULT

* Gantikan nilai token pada http request yang
mengandungi ralat invalid error dengan variable

${token} e

Name: |Createuser-54

Comments: |Detected the start of a redirect chain

Basic |/Advanced |

Web Server

Protocol [http]: |${Scheme} Server Name or IP: |${host}
HTTP Request

‘POST ‘V| Path: ‘Iheskfadminfmanage_users_php

|:| Redirect Automatically Follow Redirects Use KeepAlive [l Use multipart/form-data |:| Browser-com

| Parameters |/BodyData |/Files Upload |

Send Parameters With the
Name: Value
NMOUTY_CUSLOMmer__new |
notify_customer_reply 1
show_suggested 1
reload_time 30
secmin sec
notify_new_unassigned 1
notify_new_my 1
notify_reply_unassigned 1
notify_reply_my 1
notify_assigned 1
notify_note 1
notify_pm 1
a new
token |${token}




VERIFYING RESULT

Response Assertion, TIPS!

e Goto View Result Tree
e Choose HTML

View Results Tree

Name: |Vi ew Resuits Tree

* Click Response Data

Comments: |

Write results to file / Read from file

 Choose Unique Word..

Filename ‘

| Browse... | Log/Display Only: | | Erro

......................................................................................................................................................................................................................

%7 Landingpage-44
@ Landingpage
o- @ Login45
& Login-46
i Login-48
& Login
& Clickusers-52
& Clickusers
o= %9 Createuser-54
@ Createuser-56
& Createuser
& Logout-59
%2 Logout

| Sampler result i/Request i/Responsedata |

| Response Body |/Response headers |

Find

Home Users Categories Canned Knowledgebase Repo

ols  settings Profile Mail (0) Logout

Success: New user penggunal001 with password passwor

Manage users [?]

Name Email
mieza mieza{@mail.com
nama pengguna 01 enggunall@mail.comn

has been successfully added

Username Administrator Rating
mieza NO
pengguna(1l NO




VERIFYING RESULT

Tambah Response Assertion pada http request yang
mengandungi perkataan unik

Ta | HTTRR t
){; User Defined Variables eques
){ HTTP Request Defaults Name: |Createuser-54
#% HTTP Cookle Manager Comments: |Detected the start of a redirect chain
#% HTTP Cache Manager
% CSV Data Set Config | Basic | Advanced |
() Uniform Random Timer
¢ <L createuser Web Server
¢ = Recording Controller—createuser Protocol [http]: |${scheme} Server Name or IF
o= = Landingpage ; HTTP Request
o = Login ‘POST ‘ V| Path: /hesk/admin/manage_users php
%= 1z Clickusers |:| Redirect Automatically Follow Redirects Use KeepAl
9 = Createuser 2
@ . i | Parameters |/ Body Data V Files Upload |
¢ gz Createuser- = -
){ HTTP B Add b Assertions P Response Assertion
& ﬁ}, Createuser- Insert Parent " Timer 3 J.SON Asse.rtlon B
o= = Logout Cut Erisd Pre Processors P Size Assertion —
e JSR223 Assertion
o 4 createticket Copy BIHE Post Processors P ) —
e Past Ctrl-v XPath2 Assertion —
o g viewreport asc.e ' Config Element P - B
- View Restlts Tree Duplicate Ctrl+Shift-C e , Compare Assertion B
. Summary Report Remove Delete TS SIgTeT Duration Assertion |
o~ 88 HTTP(S) Test Script Rec( Open... mw__ r bl ol T —
Merge _unassigne JSON JMESPath Assertion |
Lmy c —
Save Selection As... ned MDS5Hex Assertion
Save as Test Fragment SMIME Assertion B
XML Asserti
Save Node As Image Curl-G ssertion —
XML Schema Assertion
Save Screen As Image Cirl+Shift-G =
XPath Assertion =
?haw? BeanShell Assertion I




VERIFYING RESULT

Response Assertion

Response Assertion

Name: Response Assertion-BerjayaDaftar

Comments:

Apply to:
(O) Main sample and sub-samples  (®) Main sample only () Sub-samples only () JMeter Variable Name to use

Field to Test
r@l Text Response O Response Code O Response Message O Response Headers
() Request Headers (7) URL Sampled () Document (text) [ ] Ignore Status

(O Request Data

Pattern Matching Rules

(® Contains| () Matches () Equals () Substring [ |Not []JOr

Patterns to Test

IJ. Pendaftar Akaun Baru SPAS Ber‘jayal

Patterns to Test

Add Add from Clipboard Delete




VERIFYING RESULT

Response Assertion

Response Assertion

Name: |Response Assertion |

Comments: | |

Apply to:
(O Main sample and sub-samples ® Main sample only (O Sub-samples only () JMeter Variable Name to use |

Field to Test
[® TextResponse () Response Code (0 Response Message () Response Headers
(O RequestHeaders () URL Sampled () Document (text) [ | Ignore Status

(O RequestData

Pattern Matching Rules

@ contains (J Matches () Equals () Substring | |Not [ | Or

Patterns to Test

Patterns to Test




VERIFYING RESULT

3. View Summary Report

« The summary report creates a table row for each differently named request in your test
« JMeter takes into account the total time over which the requests have been generated

Summary Report

Name: |Summar3ur Report |

Comments: | |

Write results to file / Read from file

Filename ‘ | Log/Display Only: D Errors D Successes Configure
- Label # Samples Average Min Max Std. Dev. Error % Throughput Received KBfsec| Sent KB/sec Avg. Bytes
|| Landingpage-44 1 20 20 20 0.00 0.00% 50.0/sec 262.35 17.48 53730
| Landingpage 1 20 20 20 0.00 0.00% 31.9/min 279 0.19 53730
|| Login-45 1 102 102 102 0.00 0.00% 9 8/sec 132592 12.22 13684900
|| Login-46 1 33 33 33 0.00 0.00% 30.3/sec 407514 15.83 1377070
| Login-48 1 15 15 15 0.00 0.00% 66.7/sec 78014 2598 11983.0
|| Login 1 150 150 150 0.00 0.00% 11.3/min 5282 0.41 2881800
|| Clickusers-52 1 116 116 116 0.00 0.00% 8 6/sec 1359585 464 16149690
|| Clickusers 1 116 116 116 0.00 0.00% 24 8/min 65063 0.22 16149690
|| Createuser-54 1 137 137 137 0.00 0.00% 7 3/sec 1152940 14 .46 16174370
|| Createuser-56 1 79 79 79 0.00 0.00% 12 Tisec 19983 42 6.84 1616579.0
|| Createuser 1 216 216 216 0.00 0.00% 19.7/min 1037.86 0.83 3234016.0
| Logout-59 1 16 16 16 0.00 0.00% 62 5/sec 32202 36.74 5276.0
| Logout 1 16 16 16 0.00 0.00% 44 6/min 383 0.44 5276.0
fToTAaL 13 79 15 216 6297 0.00% 55.6/min 71714 0.88 7919714




LOOP CONTROL

Setiap pengguna akan menjana 3 tiket setiap seorang

¥ & hesk4.0
.}c'i’: User Defined Variables
#2 HTTP Request Defaults
..‘-z'i’: HTTP Cookie Manager
# HTTP Cache Manager
(}1,' Uniform Random Timer
#. CSV Data Set Config - userbaharu

# CSVD

A CSVD
> _'_ﬁ;_ creates Add Think Times to children
» i createl Apply Naming Policy
v 4" createl Change Controller
Vi Rec| |hgert Parent
v oz Ld
> Cut
Copy
>z L4 paste
>3 H Duplicate
> = Ld
» 40 viewre| Remove
o ViewR Open...
s S"(g'm Merge
- Jp@gce .
» I HTTP Save Selection As...
Save as Test Fragment
Save Node As Image
Save Screen As Image
Enable
Disable

Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+Shift+C

Delete

Ctrl+G
Ctrl+Shift+G

Transaction Controller

Name: Login

Comments:

_ Generate parent sample

— n of timer and pre-post proces|
Sampler
Logic Controller IBeanioler
Assertions Transaction Controller
Timer Loop Controller

While Controller
Pre Processors

Post Processors Critical Section Controller

R ForEach Controller

Include Controller

¥y ¥V Y v VvV Y BRAY

Listener
Interleave Controller

Once Only Controller
Random Controller
Random Order Controller
Recording Controller
Runtime Controller
Simple Controller
Throughput Controller
Module Controller

Switch Controller

¥ . hesk4.0
# User Defined Variables
#2 HTTP Request Defaults
}33: HTTP Cookie Manager
#. HTTP Cache Manager
{P:,' Uniform Random Timer
#. CSV Data Set Config - userbaharu
#5 CSV Data Set Config - user
#. CSV Data Set Config - admin
» < createadmin
b L3 createuser
¥ <4 createticket
¥ iz Recording Controller-createticket
Y i Landingpage
» ~* Landingpage-1
> Login Name:
> NewTicket
NewTicket
Submitticket
Home
Logout
> 4 viewreport
4 View Results Tree
-. Summary Report
- jp@gc - Active Threads Over Time
> HTTP(S) Test Script Recorder

Loop Controller

i

Loop Count: [ Infinite 3

[T T T

yv

>
>

£ &

Loop Controller



LET'S DO IT




4. PERFORMING LOAD TEST
v P1 -CSV File
v' P2 -Timer (Think Time)
v P3 - Smoke Test




PERFORM LOAD TEST
1. Add CSV File

* This element that allows you to use external data sets in a CSV format.

File Edit Search Run Options Tools Help

O8adX B0+ =P r@0|ddar:EH poooa Ao o0 €
= —
K Add > Threads (Users) >
: aste rl+ onfig Elemen ata Set Config
K Past Ctrl+V Config El t > CSV Data Set Confi
é Listener > HTTP Header Manager
- Open... bs
] HTTP Cookie Manager
S ? Merge Timer > g Value
- ) HTTP Cache Manager
Save Selection As... X
HIBHEEEEETS HTTP Request Defaults
Save Node As Image Ctrl+G Post Processors >
Counter
Save Screen As Image Ctrl+Shift+G Assertions > Delete Up Down
DNS Cache Manager
nable >
izl =t liza e FTP Request Defaults
Doz Non-Test Elements > HTTP Authorization Manager
Vel C Functional Test Mode (i.e. say JDBC Connection Configuration
Help _ecting Functional Java Request Defaults t performance.
Add directory or jar to classpath Keystore Configuration

) LDAP Extended Request Defaults
Library

LDAP Request Defaults

Login Config Element




PERFORMING LOAD TEST

Add CSV File

CSV Data Set Config

Name: CSV Data Set Config

Comments:

- Configure the CSV Data Source

Filename

File encoding

Variable Names (comma-delimited)

Ignore first line (only used if Variable Names is not empty)

Delimiter (use "\t' for tab)

Allow gquoted data?

Recycle on EOF ?

Stop thread on EOF ?

Sharing mode

C:/Testplanjmeter/project2021/MyMInD/loginurusetia.csv

Browse...

nokp,password

True

r

False
False
True
All threads




PERFORMING LOAD TEST
Add CSV File RS

Name: | Login133 /index.php/ms/log-masuk/admin-portal

Comments: Detected the start of a redirect chain
A

Basic Advanced
Web Server

Protocol [http]: http Server Name or IP: Port Number:

HTTP Request

Method: POST ¥ Path: /index.php/ms/log-masuk/admin-portal Content encoding: utf-8
Redirect Automatically v Follow Redirects v Use KeepAlive Use multipart/form-data Browser-compatible headers

Parameters Body Data Files Upload

Send Parameters With the Request:

Name: Valye RL Encode? Content-Type Include Equals?
A

username ${loginid} text/plain
password ${password} text/plain
STt text/plain
option com_users text/plain
task user.login text/plain

Y . Y, W NP Y N I T . T N N PR PN N e

AR

Detail Add Add from Clipboard Delete Up




PERFORMING LOAD TEST

Timer

« Timers are used to define the time period that you want to wait between requests
« By default, a JMeter thread sends requests without pausing between each request
« |tis recommend that to specify a delay by adding one of the available timers to the Thread Group

File Edit Search Run Options Tools Help

P P . 4 i i k= o ] e
e aE e BD el ‘b’ boa‘ﬂﬂ‘ﬂ%}‘;.h 00:00:00 &oo/o@
- Add > Threads (Users) >
- ﬁ: H
—#H Paste Ctrl+V Config Element >
-5 H
Q} u Listener > . )
-3 C Open.. e T e Uniform Random Timer
Egg E Merge Timer > Constant Timer Value ‘ Name: |Uniform Random Timer
Save Selection As... Uniform Random Timer Comments:
Pre Processors >
S Node As | Ctrl+G P > N Precise Throughput Timer Thread Delay Properties
ave Node As Image - Ctri+ ost Processors Random Delay Maximum (in milliseconds): | 5000

Constant Throughput Timer

i i > :
Save Screen As Image Ctrl+Shift+G Assertions Delete Up Down Constant Delay Offset (in millisecands): | 500

Gaussian Random Timer
Test Fragment b

JSR223 Timer
Disable Non-Test Elements >

Poisson Random Timer

Toggle Curl+T unctional Test Mode (i.e. save

Synchronizing Timer

Help ecting Functional 1 fect performance.

BeanShell Timer

‘ | Add directory or jar to classpath Browse... Delete Clear




PERFORMING LOAD TEST

Perform Smoke Test
> Add JMeter Plugin

Test plan > Add > Listener > jp@gc - Active Threads Over Time

Monitor thread using jp@gc - Active Threads Over Time




LET'S DO IT
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JMeter Plugins Installation Guide

Download plugins-manager.jar and put it into Lib/ext directory, then restart JMeter.

File Edit Search Run  Options Help
. # ‘ Eunction Helper Dialog Ctri+Shift-F1
- Look and Feel
¥ A TestPlan Log Viewer
» -m- Thread Group Log Level
n HTTP(S) Test Scrip SSL Manager Ctrl-M ad Group

Choose Language

oup

Collapse All Ctri-Minus taken after a Sampler error

Expand All Ctrl+Shift-Minus
ue Start Next Thread Loop Stop Thread Stop Test Stop Test Now

Zoom In

Zoom Qut s

Save automatically before run hreads (users): 20

#% Plugins Manager e
nanp-wp 1 =r0d (in seconds): | 100
Loop Count: Forever 1

Delay Thread creation until needed

A Scheduler

Scheduler Configuration

Duration (seconds) 300

Startup delay (seconds)




JMeter Plugins Installation Guide

& JMeter Plugins Manager X

Installed Plugins Available Plugins Upgrades

A4 jmeter - FTP Protocol Support
v jmeter - HTTP Protocol Support
v/ jmeter - JDBC Support

v jmeter - JMS Support

v jmeter - JUnit Support

v jmeter - Java Components

v jmeter - LDAP Protocol Support
¥ jmeter - Mail/lSMTP Support

A jmeter - MongoDBE Support

v jmeter - OS Process Support
v jmeter - TCP Protocol Support

A jmeter - Various Core Components

v jpgc - Standard Set Version:

Review Changes

Apply Changzs and Resiart Jilzier




JMeter Plugins Installation Guide

Available Plugin > select jpgc-Standard Set > Apply Changes and Restart JMeter

File Edit Search Run Options Help
& = v g B +

v Te—+r-|-\.- - _
A Add » Threads (Users) View Results Tree
T e Summary Report
Paste Config Element

. Aggregate Report

Open Listener :
pen... Backend Listenel
Merge Timer a a I
ggregate Graph N
Save Selection As... Pre Processors . d Variables
Assertion Results

Save Node AsImage  Ctl-G bl Comparison Assertion Visualizer

Save Screen As Image cti+shité  Assertions Generate Summary Results
Test Fragment * Graph Results

Disable Non-Test Elements ¥ SR223 Listener

Toggle Mailer Visualizer

Response Time Graph

Help :' Run Thread G

Save Responses to afile
Y Run tearDow Simple Data Writer eads

Functional Te View Results in Table iler Data)

jp@gc - Active Threads Over Time -

Selecting Function
jp@gc - Bytes Throughput Over Time




